
 

  

 
2020 Knowledge Based Examinations of Service Organizations 

January 2020 

CCH® ProSystem fx® Knowledge Coach 

Welcome to 2020 Knowledge-Based Examinations of Service Organizations for Knowledge Coach 

This document provides important information about the 2020 release of Knowledge Based Examinations of Service Organizations. Review 
this information carefully. If you have any questions, additional information is available on CCH Support Online. 

New in this Release  

Knowledge-Based™ Examinations of Service Organizations 
 
This title can be installed on CCH® ProSystem fx® Engagement v2018 by first installing the CCH ProSystem fx Engagement v2018.2.4 Update 
for Knowledge Coach. The latest update can be downloaded here. This update allows you to use the 2020 content without installing 
Engagement v2019 until your firm plans to update. 

This title is designed to help the practitioner efficiently and effectively conduct examination engagements of service organizations in 
accordance with applicable standards issued by the American Institute of Certified Public Accountants (AICPA). The knowledge-based 
methodology for service organization engagements is a risk-based methodology for conducting examination engagements of service 
organizations. It emphasizes using knowledge of the entity, subject matter, and criteria to make the risk assessments and recommendations 
in connection with an engagement. The more accurately a practitioner assesses risks of material misstatement or deviation, the more 
assurance the practitioner has that the procedures performed in response to the risk assessments will detect material misstatements or 
deviations. 

Examinations of service organizations are often unique and complex, and require specialized accounting and attestation knowledge. 
Conducting examinations of service organizations requires the exercise of the practitioner’s professional judgment. This edition includes 
specific up-to-date guidance for examinations of service organizations and is published for the purpose of communicating to users of the 
toolset information about the updates and enhancements in the current version. This document is not, and should not be used as, an 
engagement program to update the documentation of an engagement started in a previous version of this product. 

The forms and practice aids in the knowledge-based methodology help the practitioner perform the procedures necessary to complete the 
engagement in accordance with professional standards. The knowledge-based tools include documents, attestation programs, practice 
aids, correspondence, and example reports. 

If you are updating from a previous version of this title, refer to the Knowledge Coach User Guide Chapter 12. The guide is found on the 
Engagement File Room Help menu.  

The 2020 documents include CCH® Accounting Research® material links to specific guidance that provide instant access to detailed analysis 
related to the steps and processes discussed in the workpapers.  

http://support.cch.com/productsupport/
https://support.cch.com/updates/Engagement/release2018/release2018.aspx
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2020 Edition of Knowledge-Based Examinations of Service Organizations  
This edition features numerous enhancements, including:  

• Combining ATT-401 Understanding Entity-Level Controls: Complex and ATT-401N Understanding Entity-Level Controls: Non-
Complex, giving the practitioner the option to memo or complete the detailed table for each section based on tailoring. 

Roll Forward Note: If you used the non-complex document in your prior engagement, before rolling that file forward, you must add 
the complex document to your engagement binder to retain the data from the non-complex document. Then, remove this 
workpaper from the prior year binder after you have rolled the binder forward. 

If your binder has been finalized and you don’t want to unfinalize it to insert the complex document before rolling forward from the 
2019 version, make a copy of your finalized binder and insert the applicable complex document. Then, roll forward the copied 
binder to the 2020 title version. After roll forward, remember to delete the copied prior year binder from your file room. Doing this 
retains the data in the 2020 combined version.  
 
Alternatively, copy and paste the data from the prior year non-complex document from the prior year binder after you roll forward 
to the current combined versions. The non-complex document will roll forward as an obsolete workpaper with no data. It will need 
to be removed after you have rolled forward your binder. Refer to your prior year binder for data in the non-complex document.  
 
For “update knowledge coach content,” insert the complex version of the workpaper prior to updating to retain information from 
the now obsolete non-complex version. We recommend that you publish the non-complex version prior to running the “update 
knowledge coach content” option so that the user has access to the data. After updating, the non-complex version will be obsolete. 
 
By performing an option above, the Relevant Principle tables and Section IV: Conclusion from the non-complex document will be 
retained in the new combined document. This option works the same as the Commercial KBA-401 workpaper. 

• Modifying the KBA-201 Attestation Client/Engagement Acceptance Form to allow users the option to memo or complete the 
detailed table for each section based on tailoring.  

• Adding flow of columns “Nature of Other Services” and “Firm Personnel Overseeing the Service” from AID-101 Overall 
Examination Engagement Strategy to AID-201 Nonattest Services Independence Checklist. 

• Adding one new column (If Controls are Not Effectively Designed and Implemented or Are Not Operating Effectively, Describe the 
Risks of Material Misstatement) in ATT-402 Understanding General Controls for Information Technology in the “less complex” table. 
This new column contains a dynamic list of risks noted in KBA-501 Risk Assessment and Attest Program: Examination-Level 
Engagement. 

• Enhancing instructions, practice points, and procedures throughout the toolset to improve workflow. 

Click here for the 2020 Examination of Service Organizations Title Overview for Knowledge Coach Users. 

In addition, forms and practice aids throughout have been updated to include new examples and tips, and where applicable, to take into 
account new literature, standards, and developments reflected in the following current audit and accounting guidance:  

• AICPA Auditing Standards Board (ASB) Statements on Standards for Attestation Engagements (SSAE) No. 20, Attestation Standards: 
Amendments to the Description of the Concept of Materiality 

• 2018 Revision of Government Auditing Standards (GAGAS, or the Yellow Book) 

• QC Section 10, A Firm’s System of Quality Control 

• The revised AICPA Code of Professional Conduct (Code), including the provisions of ET Section 1.295, Nonattest Services 

• AICPA AAG, Reporting on Controls at a Service Organization Relevant to Security, Availability, Processing Integrity, Confidentiality, 
or Privacy (SOC 2) – Revised 2018, 2017 Trust Services Criteria, and DC Section 200 – 2018 Description Criteria 

http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2020%20Service%20Organizations%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
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Important: 

• Save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated. 

• If Microsoft® Word crashes when using Knowledge Coach, before closing the binder, use the Save Knowledge Coach Answers 
option in the binder view under the Tools menu. This action saves all data within tables. 

• You can view other Knowledge Coach best practices on our Support Web site. 

System Requirements 

This title requires the 2019 Financial Statement Base Title. The 2019 Financial Statement Base title MUST be installed with one of the 
following versions of CCH® ProSystem fx ® Engagement and Knowledge Coach: 

• Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or later available here. To identify 
the version you are running, please go to the Help > About window in the application.  

• Engagement and Knowledge Coach v2019 or newer. 

If you are upgrading from Engagement v7.1 or older, please contact Technical Support. 

A minimum of 4GB of RAM is required for optimal performance when opening and navigating Knowledge Coach workpapers. 

License Requirements 

This title requires the Knowledge-Based Examinations of Service Organizations license. Users who do not have a license for this title will not 
be able to use Knowledge Coach functionality in workpapers.  

For information on updating your licensing, see How do I add or update CCH ProSystem fx Engagement Licenses? on our Support Web site.  

For more information on assigning licenses, see How do I assign Engagement Licenses? on our Support Web site. 

Download Instructions 

If you plan to use this title on Engagement and Knowledge Coach v2018, apply the CCH ProSystem fx Engagement v2018.2.4 Update to all 
computers, including Admin and terminal servers, before installing the title. Review the update's release notes for more deployment 
information. 

To download this title: 

1. Navigate to the Knowledge Coach Updates section of the Engagement Support Web site.  

2. Select the Knowledge Coach Series. The series are arranged by title type, then industry. 

3. Click Download File next to the title you want to download. 

Note: On some occasions the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, change the 
extension of the downloaded file to KCP, using all capital letters. 

You must install the 2019 Financial Statement Base title before installing the 2020 Knowledge Based Examination of Service Organizations.  

The Financial Statement Base title is also available on the Knowledge Coach Update Web site.    

https://support.cch.com/kb/solution/000034942/sw34947
https://support.cch.com/updates/Engagement/release2018/release2018.aspx
https://support.cch.com/contact
https://support.cch.com/kb/solution.aspx/sw3937
https://support.cch.com/kb/solution.aspx/sw3943
https://d2iceilwdglxpz.cloudfront.net/release_notes/CCH%20ProSystem%20fx%20Engagement%202018.2.4%20Release%20Notes.pdf
http://support.cch.com/updates/KnowledgeCoach
http://support.cch.com/updates/KnowledgeCoach
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The Knowledge Coach Content Package (KCP) download is a proprietary file that must be installed from within Engagement. Save this KCP 
file to a location on your local drive, and follow the Installation Instructions below. 

Installation Instructions 

See How do I add a new CCH® ProSystem fx® Knowledge Coach title to CCH® ProSystem fx® Engagement? for instructions on installing a 
new Knowledge Coach title. 

Online Permission Key 

Permission key files can be downloaded from our Web site or when adding or updating the new licenses in Engagement v2018 and newer. 
After updating the license file in the Engagement Admin module, licenses must be assigned to the staff who will use 2020 Knowledge-Based 
Examinations of Service Organizations. 

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.  

Using Your Knowledge Coach Content with CCH® Accounting Research Manager® 

CCH Accounting Research Manager (ARM) is the most comprehensive, up-to-date, and objective online database of financial reporting 
literature. It includes all authoritative and proposed accounting, attestation, and SEC literature, plus independent, expert-written 
interpretive guidance.  

Available on ARM, the Knowledge-Based Examination of Service Organizations Guide helps you comply with the most recent professional 
standards and guidance for the conduct of Examination of Service Organizations and to integrate the use of practice aids, tools, and other 
resources with its guidance. This publication supplements and complements the knowledge-based documents that are available in 
Knowledge Coach. 

If you subscribe to an ARM library that includes Examination of Service Organizations content, you can link directly to source material from 
Resources within Knowledge Coach documents. These links have been updated to refer to the accounting standards under the FASB 
Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based Examination of Service Organizations Guide on ARM, 
you can take advantage of references to the guide material from within the Knowledge Coach documents.  

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about our 
content, our experts, and how you can request your free trial by visiting the Accounting Research Manager Web site. You can also access 
the Accounting Research Manager Web site by selecting Engagement > Binder Window > Shortcuts Bar > Guidance tab.  

Using Your Knowledge Coach Content 

To use your Knowledge Coach workpaper templates, do the following: 

1. Open a binder in Engagement. 

2. Select the workpaper tab into which you would like to insert the workpaper. 

3. Select New Knowledge Coach Workpaper from the toolbar or File menu.  

4. Select the new Knowledge Coach title with the content you would like to use. You can only select titles you have installed. The 
information displayed changes to reflect the workpaper organization available for the selected title.  

5. Select the Knowledge Coach workpapers to insert into your binder and click OK.  

https://support.cch.com/kb/solution/000033707/sw30271
https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
http://www.accountingresearchmanager.com/
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6. In the Selected Workpaper Properties window, add a workpaper index in the Index field and make any name modifications that are 
needed. You can also modify the tab location or the roll forward settings for each workpaper. 

7. Click OK. The integrated Knowledge Coach workpaper is now inserted into your engagement binder.  

Note: For more information on how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.  

Additional Information on Knowledge Coach and the KBA Methodology 

Knowledge-Based Audit (KBA) Methodology allows the results of one set of procedures to become the input for the next. The key 
components of the KBA methodology include: 

• An overview that guides practitioners through the methodology 

• Knowledge-based attestation documents, integral to risk assessment and attestation processes, which contain steps and 
procedures required by professional standards 

• Customizable engagement programs that take practitioners through related steps and procedures 

• Practice aids to help practitioners complete steps or processes outlined in the knowledge-based attestation documents and 
attestation programs 

• Practitioner’s reports that provide a variety of sample practitioner’s opinions on nontraditional engagements 

• Correspondence documents that provide sample letters to be used to comply with professional standards, SSAE, and SSCS 
requirements and in other common situations 

CCH® ProSystem fx® Knowledge Coach 
Knowledge Coach functionality allows practictioners to use the Knowledge-Based-Audit methodology more efficiently by eliminating the 
need for duplicate entry of the same information, tailoring engagement documentation to each particular engagement, and documenting 
the link between risks identified and procedures performed. ATT-100 Tailoring Question is a document in Knowledge Coach that presents 
engagement-level questions designed to aid in tailoring the engagement documentation to fit each client. Completing the questions helps 
the practitioner avoid duplication and unnecessary workpapers.  

Note: Before you begin your engagement, review the guidance in ATT-101 Overall Attestation Program. This workpaper is your road map 
through a Knowledge-Based Audit methodology. Start your engagement with ATT-100 Tailoring Question Workpaper and ATT-101 Overall 
Attestation Program. 

• Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-501 
Summary of Risk Assessments. This allows you to continuously assess risks during the engagement. Several workpapers prompt you 
to consider the presence of risks, but the Risk Summary task pane must be used to document those risks. All documented risks flow 
to the Risk Summary. To ensure risks show in findings tables, select the workpaper identified in field of the Risk pane. 

• Information Flow helps reduce the time spent duplicating information across forms. In addition, the flow of consistent information 
ensures that information and updates to information are not missed between workpapers. Drill-down functionality helps the user 
navigate quickly to the source of the information, aiding in the review of the engagement file. 

• Diagnostics help track unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks or relevant 
assertions, missing workpaper, and more.  

• Links to Accounting Research Manager (ARM), If you subscribe to an ARM library that includes attestation content, you can link 
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference the 
accounting standards under the FASB Accounting Standards Codifications and the attesation standards issued by the AICPA. Also, if 
you subscribe to the Knowledge-Based Examinations of Service Organizations Guide on ARM, you can take advantage of links to the 
attestation guide material in the Knowledge Coach documents. 
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• Interpretive Guidance is integrated in each Knowledge Coach template through the Tips view of each new task pane. Informational 
features include Practice Points, Examples, Optional Workpapers, and Resources to help practitioners work more effectively and 
efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s Accounting Research Manager 
and industry attestation guides by simply clicking on the reference.  

Download Description 2020 Knowledge-Based Examination of Service Organizations  

Version 

Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or 
later 
OR  
Engagement and Knowledge Coach v2019 or later 

2019 Financial Statement Base 

Release Date January 2020 

File size 18MB 

Approx. Download Time 42 minutes at 56 kbps 

License Full Version 

Platforms Microsoft® Windows® 8.1 and 10 

Office Microsoft® Office 2013 or higher required 
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